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Course Topics:

I. MS PowerPoint 2003 Overview
Il. Format Slide Master
I1l. Insert Images from Internet
1VV. Customize Slide Animation
V. Embed and Link Objects
V1. Adding Sound
VIIl. Adding Hyperlinks
VIlIl. Adding a Movie

Section 1 -- Overview

What is Microsoft PowerPoint?

Microsoft PowerPoint is a presentation program, which means that it is
primarily used to create and edit text, graphics, movies, and sounds on
electronic “slides”. A PowerPoint presentation is similar to a slide show.
Unlike a word processing or spreadsheet program, every object on a
PowerPoint slide is a graphic, including text.

PowerPoint presentations are used for a variety of purposes, such as

Marketing
At convention booths, kiosks, line monitors, or Board Room

pitches, sales people use PowerPoint to present products and
services and to describe the advantages of one company over
another.

Fundraising
To describe the needs of their organization and to show how
the charitable funds are distributed, fundraisers use
PowerPoint to get their message across.

Lectures
In classrooms around the world, teachers find PowerPoint a
valuable tool in presenting concepts to students in new and
interesting ways.

Meetings and Conferences
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To present new ideas, communicate corporate goals, or
justify budget items, employees use PowerPoint in addition to
paper handouts to move their companies forward.

Section 2 -- Format presentation using slide masters

Slide Masters

Every presentation has slide masters that control the overall appearance and
layout of each slide. The master slide contains all the formatting information
that the template brings into the presentation. All changes made to the master
slide will be reflected on each slide in your presentation. From a design aspect,
it is best to change any text formatting from the Master Slide to maintain
consistency throughout your presentation.

Slide Master — Settings on the Slide Master change the looks of all the slides
except the Title slide.

Title Master — Settings on the Title Master change the looks of the Title slide
only.

Handout Master — Allows you to choose an outline or how many slides will
print out onto each handout.

Notes Master — Allows you to set up the notes page view so that outline and
slides are visible.

Formatting Text from the Slide Master

To Format Text using Slide Masters:

1. Start Microsoft PowerPoint (Start > All Programs > Microsoft Office >
Microsoft Office PowerPoint 2003).

A Getting Started Task Pane automatically appears on the right.

Click the option under Open for “More...” = M= or click File >
Open.

2. Open the file called “Class Done Capsules.ppt”, located in the My
Documents area in the Training/PowerPoint folder.

3. Click View on the Menu bar a, point to Master, then click either Title
Master or Slide Master. Select the Header placeholder and change the
text to formatted.

4. Use the formatting toolbar to make changes or use the Format Menu’s
Font option.
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5. Once your formatting is complete, return to the slide view by clicking
View on the Menu bar and then click Slide or Normal depending on your
version of PowerPoint or click the Close button on the Master toolbar.
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To Change the Bullet Style from the Master Slide:
1. Click View on the Menu bar a, point to Master, then click Slide Master.

2. Click the line that you would like to change the bullet for to insert your
cursor.

3. Click Format on the Menu bar, then click Bullets and Numbering.
4. Click on a different bullet character and click OK.

5. Once your formatting is complete, return to the slide view by clicking
View on the Menu bar and then click Slide or Normal depending on your
version of PowerPoint or click the Close button on the Master toolbar.

Note: To access more bullet styles, after step 3 click the Picture button.

Adding Images to the Master Slide

If you would like to have a particular image or logo appear on each slide of the
presentation, you should add that image/logo using master slides.

To Add an Image to the Master Slide:
1. Click View on the Menu bar then point to Master, then click either Slide
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Master.

2. Select Insert on the Menu bar, then point to Picture, and then click Clip

Art or From File. If you picked ClipArt, type the ClipArt category then
click the picture that you would like to insert or from the Pop-up menu
click the arrow, this is the Insert button. If you picked From File, Use the
Look in drop down list to locate the picture. Click the name of the
picture and click Insert.

3. Once your formatting is complete, return to the slide view by clicking

View on the Menu bar and then click Slide or Normal depending on your
version of PowerPoint or click the Close button on the Master toolbar.

Section 3 -- Insert images from the Internet

Just as clip art pictures and pictures stored on disk can be inserted into a
presentation, an image from the Internet can also be used in a presentation.
When using images captured from the Internet, you need to be careful of
copyright laws. A good rule of thumb is “When in doubt, don’t do it.”

To Capture an Image from the Internet:

1.

2.

3.

Find the image you want to capture.
Right click in the middle of the image.
Click Save image As from the pop-up menu if you are using Netscape.

Click Save Picture As from the pop-up menu if you are using Internet
Explorer.

. Your browser will take over asking you where to save the image and what

to name it. (Please make note of the location where you are saving the
image and the name.)

. Click Save.

. Select Insert on the Menu bar, then point to Picture, and then click

From File. Use the Look in drop down list to locate the picture. Click
on the name of the picture and click Insert.

Section 4 -- Customize slide animations

The Preset Animation options (discussed in the Beginning PowerPoint handout)
are a quick way to set animations on text and other objects. There are more
text and object animation options available under the Custom Animation
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command. In the Beginning PowerPoint handout, you were given a method to
animate all objects on a slide in the same manner. The Customize Animation
option will let you give different animation settings to different objects found on

the same slide.

To Customize Animations:

1. In Slide view or Normal view depending on your version of PowerPoint, go

to the slide to be changed.

2. Click Slide Show on the Menu bar, and then click Custom Animation.

3. If there is animation on the slide then in the top portion of the Custom
Animation dialog box, you will see a list of all objects on a particular slide.
To edit the animations, select the text box that corresponds to the object

you wish to apply animation to.

Custonm Anination - 4
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Modify: Blinds
Start "'"_.',5 O Click L
Direction: | Horizontal w 6.
Speed: Very Fast
193 S Text2:1999-1,.,. w 7.
v 8.

493 # mcon40sz120000[1]
5“5 #fF MC03983550000[1]

(Only select one at a time.)

Click the Add Effect tab if necessary.
For the Entrance animation, choose the
animation effect by clicking on the
selection. If necessary, you can choose
animation for the Emphasis and Exit
selections.

Repeat steps 3-5 for each additional
object you would like to animate on the
slide.

Then click the Re-Order tab.

In the Animation order list, if necessary,
click the object that you wish to change
the animation order for, then click either
the Up or Down arrow.

. If you would like to automate the

animation, select the Arrow in the Start
animation section, then make your
select.

10. Click Play to view a Preview of your

ir Re-Order
l." Play I [ Slide Show J

AukoPrensiam
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Section 5 -- Add sound to your presentation

It is possible to add sound files to a slide, and have them played at a special
time during the slide’s presentation.

To Add a Sound from a File:

1.

In Slide view or Normal view depending on your version of PowerPoint, go
to the slide that you want to add sound to.

. Click Insert on the Menu bar, point to Movies and Sounds, and then

click Sound from File.

. Locate the sound file.

Click on a sound file, and click OK.

. Click No to have the clip play manually.

. A sound icon has been placed in the middle of your slide. You can move or

re-size it.

. To hear a preview of the sound, double click on the icon.

. When you run the slide show, you’ll have to click on the icon to hear the

sound.

. To delete the sound file, click the icon and click Delete on the keyboard

or choose Remove from the Custom Animation menu.

To Animate the Sound:

1.

6.

In Slide view or Normal view depending on your version of PowerPoint, go
to the slide that you want to modify the sound animation for.

. Click the speaker icon to select it.
. Click Slide Show on the Menu bar, and then click Custom Animation.

. Click the Add Effect tab to animate the Entrance, Exit, Emphasis of the

sound icon

If necessary, select the Start on Click mode under the Modify Play
Settings.

If necessary, click the Re-Order tab. In the Animation order list, if
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necessary, click the object that you wish to change the animation order
for, then click either the Up or Down arrow.

7. Click Play to view a Preview of your settings.

Section 6 -- Embed and link objects together

Many types of objects can be added to a slide show. Objects added to a slide
can be referenced two different ways:

e Embedded Object: An object can be embedded into the slide in which case
the object in its current state is placed directly onto the slide. When we
create a new object from the Insert Object dialog box, we are creating an
embedded object. Practical examples here are a MS Word table or an
Organizational Chart.

» Linked Object: An object can also be linked to a slide in which simply a
reference to the objects actual location is what is placed onto the slide, so
that if the object changes, those changes will be seen when the object is
selected from the slide show. When we choose Create from file in the Insert
Object dialog box, we have the option to insert the object as linked. This
feature is useful when we want to reference a MS Word or MS Excel file from
a presentation. We don’t want the file itself to be placed on the slide, instead
we want to view that file in the program it was created by.

Insert Object

Lo |
() Create new Eilg: QK
[ covel ]

(%) Create fromfile | CADnrnments And Sekting<iosaei My Doeonmenbsi b Aining
[Ipisplay as icon

Resulk

Inserts a picture of the file contents into wour presentation,

—*@ The picture will be a shorkcut to the file so that changes to
the File will be reflected in wour prasentation,

To Insert a Linked Object:
1. In Slide view or Normal view depending on your version of PowerPoint, go
to the slide to be changed.

2. Click Insert on the Menu bar then click Object.
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3. Click the Create from file radio button.

4. Click the Browse button to find the file you wish to reference.
5. Locate the file, select the file and click OK

6. To create a link, click on the Link box. Then click OK

7. You can now move the object or resize it on your slide.

To Embed an Organizational Chart:
1. In Slide view or Normal view depending on your version of PowerPoint, go
to the slide to be changed.

2. Click Insert on the Menu bar then click Picture.
3. Click Organization Chart.

4. Edit the chart

Section 7 -- Adding Hyperlinks to a Presentation

Hyperlinks can link to other objects such as Word documents, Excel
spreadsheets, etc. In addition, Hyperlinks can link to websites and even to
other slides in the same or a different presentation. Unlike embedded objects,
objects accessed via a hyperlink will not be viewable from within the
presentation. The originating program of the object will open. For instance, if
you create a hyperlink to a Word document, Microsoft Word will open and
display the document when the link is clicked during a presentation.

To Create a Hyperlink:

1. Select the text or image you want to display as the hyperlink then click
the Insert Hyperlink button on the Standard toolbar.

2. The Insert Hyperlink dialog box will be different depending on the version
of PowerPoint you are using.

3. In the Web page name box, enter the URL of the website you wish to
link to or click Browse to locate a file to link to. To link to a specific
slide in the presentation, click the Place in This Document icon on the
left side of the dialog box. Select the title of the slide you wish to link to.

4. Click OK.
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Insert Hyperlink
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NOTE: You need to be in Slide show view to test out your link. And you need to
have an active Internet connection to use links to websites during your
presentation.

Section 8 -- Inserting a Movie

1. On the Insert menu, point to Movies and Sounds, and then click Movie
from File.

2. Click the video you want to use and then click OK.

Tip Always put the movie in the same folder as your PowerPoint
presentation. If you later move the PowerPoint presentation to another
computer, copy the movie too. Keeping your movie in the same folder as
your presentation ensures the link will still work. However, you should
always test the movie on a new machine just to be certain. Re-insert the
movie, if necessary.)

3. After you click OK, you're prompted with a message asking how you want
the movie to start in the slide show.
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Slide 2

3

Haow dia wau wank the movie ko skark
in the slide show?

when clicked |

I recommend choosing Automatically even if you want the movie to play
when clicked. (If you choose When Clicked you have to click the black box

to start the movie.)

4. You should now have a small rectangle sitting on your slide.

Inserk

|| Movies and Sounds  # | Movvie From File.. .

1

1|nsert a movie using a file on your computer or in another location, such as
a server.

2The movie appears as a still frame on your slide.

Last updated February 2006



Intermediate PowerPoint 2003 Page 11

The trick | use is to move that rectangle off the slide, so it is sitting next to
it, but not on it. You can size it down if you like. Click the movie (that is, the
rectangle) and then drag it off the slide.

Slide 2

.

Play the movie full screen

5. Right-click the movie object (the small rectangle) and on the shortcut menu,
click Edit Movie Object.

6. The Movie Options dialog box appears. Under Display Options, select the
Zoom to full screen check box, and then click OK.

Movie Options

Play options
| Loop until stopped
[ Rewind movie when done playing

Sound vaolurne: E:f]

Display options
[ Hide while nat playing

Information
Tokal plaving time:  00:07
File: C:\Movie Files\basketball. mpg

Test this now to see how it works by starting the slide show. (On the Slide
Show menu, click View Show.) Advance to the slide with the movie, within
a couple of seconds, the movie starts to play full screen. When the movie
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finishes, you return to the same slide (but no unsightly box appears). Click
to advance to your next slide.

Add an On Click effect to start the movie

If you prefer, you can click to start the movie. This requires one more step,
setting an On Click animation effect.

1. On the Slide Show menu, click Custom Animation. The Custom
Animation task pane appears on the right side of the PowerPoint window.

2. Click the movie object (the rectangle) to select it on the slide.

3. In the Custom Animation task pane, click Add Effect, point to Entrance
and then More Effects then click Appear.

Custom Animation

—" |‘5‘:;v Add Effect

Sy Entrance 3 m* 1. Appear
F%  Emphasis v |3 2 Blinds
<= Exit b | E 3 Box
d ¥3| MotionPaths » | 3| 4, Checkerboard
=n Movie Actions » | 3 5. Diamond
& &8 FAyn
More Effects...

You have added an On Click effect. The animation effect you added is the
one with the Green star next to it and a gray rectangle around it. If it
doesn’t have a gray rectangle, click it to select it. Your Custom Animation
task pane should look like the picture below (except with the name of your
movie in the list).
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4. The last step is to move that animation up to the top of the effects list. To
do this, make sure the animation effect is selected, and then click the Up
Re-order arrow at the bottom of the Custom Animation task pane. Or
simply click and drag the animation effect to the top of the effects list.

5. You are done. Close the Custom Animation
panel. Test your presentation to make sure it
works by starting the slide show. (On the Slide
Show menu, click View Show.) When you
advance to the slide with the movie, you should
not see the movie. When you click the slide, the
movie zooms to full screen and plays. When it
finishes playing, you are returned to the same
slide. Click to advance to the next slide.

Custom Animation

|5y AddEffect v| (% Remove

Modify: Appear
start: “B on click
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[F Play ] [E Slide Show ]
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